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CAREER PLANNING

m  Scenario 1: Career Planning Setup

SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY | PAGE FUNCTIONAL STEPS
# ACTOR(S) COMPONEN
T
1. User Sets up Career | HRUser Career Set Career Set Career Path > User selects the Career Planning
Path Planning Setup | Path Unit (if more than 1 are available,

else the value is defaulted)

»  If more than one value is available
then select is defaulted and the
user selects a value.

»  On selecting the Career Planning
Unit the Unit Structure Set Up
Combo is loaded with select.

»  User selects a value from the Unit
Structure set up Unit and the
respective Job Titles are displayed
in the Jobs for Career Planning
multiline.

»  User selects a Job Title and gets
the Career Tracks which is already
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defined Else selects the Job title for
which the Career Track has to be
defined and presses Get Career
Tracks and on press of the same
New Track is loaded in the Career
Track Combo

»  User selects the Unit Structure Set
Up and defines possible Jobs for
the same and saves the
information. Upon save the value
Career Track 1 is loaded in the
Career Track Combo, the sequence
No. is auto generated in ascending
order and so as the Bench Mark
Job Level Code which is associated
with the job code selected in the

multiline.
2 User modifies Career | HRUser Career Set Career Set Career Path »  User selects the Career Planning
Path Planning Setup | Path Unit (if more than 1 are available,

else the value is defaulted)

»  If more than one value is available
then select is defaulted and the
user selects a value.

»  On selecting the Career Planning
Unit the Unit Structure Set Up
Combo is loaded with select.
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Usage Manual

ramco

Co-create. Innovate. Win.

SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY | PAGE FUNCTIONAL STEPS
# ACTOR(S) COMPONEN
T

> User selects a value from the Unit
Structure set up Unit and the
respective Job Titles are displayed
in the Jobs for Career Planning
multiline.

»  User selects a Job Title and gets
the Career Tracks which is already
defined and presses Get Career
Tracks and on press of the same
Career Track 1 is loaded in the
Career Track Combo

»  User modifies the records and
saves the information. Upon save
the sequence No. is auto generated
in ascending order and so as the
Bench Mark Job Level Code which
is associated with the job code
selected in the multiline.

> User also deletes specific record in
the multiline with the multiline
delete option.

3 User deletes the HRUser Career Set Career Set Career Path > User selects the Career Planning
Career Path defined Planning Setup | Path Unit (if more than 1 are available,
else the value is defaulted)

»  If more than one value is available
then select is defaulted and the
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user selects a value.

»  On selecting the Career Planning
Unit the Unit Structure Set Up
Combo is loaded with select.

> User selects a value from the Unit
Structure set up Unit and the
respective Job Titles are displayed
in the Jobs for Career Planning
multiline.

»  User selects a Job Title and gets
the Career Tracks which is already
defined and presses Get Career
Tracks and on press of the same
Career Track 1 is loaded in the
Career Track Combo

>  User deletes the entire Career
Track with the delete button.

> User also deletes specific record in
the multiline with the multiline
delete option.
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m  Scenario 2: Performing Career Plan for Employee

SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY PAGE | FUNCTIONAL STEPS
# ACTOR(S) COMPONENT
User performs HR User Career Planning Career Plan for Select > User selects the Career Planning Unit
Career Planning for Employee Employe (if more than 1 are available, else the
an Employee e for value is defaulted)
Career »  User Selects a Planning Criteria and
Plan defaults it, or leaves the same blank

> User selects and enters one or more
of the Career Criteria

>  User may save the criteria in a new
name using the “Save Criteria”

»  User performs a search using the
given criteria

»  User provides a Planned Career Date
for the employee records

»  User directly enters the Employee
Code and takes the ‘Career Plan’ link
OR

> User conducts a search using the
filter “Planned as on Date” or “Actual
as on Date” and clicks on the multi-
line hyperlink to perform Career
Planning for the employee.
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SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY PAGE FUNCTIONAL STEPS

# ACTOR(S) COMPONENT
Career ) User records Career Plan for the
Plan for selected Employee in the multiline
Employe with Employment Unit, Job, Position
e and selects Work Location, enters

Planned From and To Date, Potential
Assessment, Remarks, Employee
specific details like Strengths,
Development Areas, Comments.

> User saves the above information

> User may visit one of the links,
Monitor Career Fitment, Request for
Training, View Appraisal Records ,
View Employee Work Experience,
View Employee at a Glance.

> User selects the record in the
multiline and thru Monitor Career
fitment page, for a given Progress
Monitor Date by pressing Get Details
the User scrutinizes the Career
Planning along with Competency
Gaps and Qualification details.

> User also can visit the View Training
Requests page for the selected
employee for effective scrutinizing of
the Career Fitment.
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2. User modifies the HR User Planning Career Plan for Select > User selects the Career Planning Unit
Career Plan for Employee Employe (if more than 1 are available, else
Employee e for the value is defaulted)
Career > User Selects a Planning Criteria and
Plan defaults it, or leaves the same blank

> User selects and enters one or more
of the Career Criteria

> User may save the criteria in a new
name using the “Save Criteria”

> User performs a search using the
given criteria

»  User selects the record by selecting
the Employee thru the multiline
hyperlink.

> User directly enters the Employee
Code and takes the ‘Career Plan’ link
OR

> User conducts a search using the
filter “Planned as on Date” or “Actual
as on Date” and clicks on the multi-
line hyperlink to perform Career
Planning for the employee.
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Career >  User selects the Basis of Career Plan
Plan for combo as Career Plan and presses
Employe Get Details
e

) User modifies the multiline details.
) User saves the above information

> User may visit one of the links,
Monitor Career Fitment, Request for
Training, View Appraisal Records ,
View Employee Work Experience,
View Employee at a Glance.

3. User deletes the HR User Planning Career Plan for Select ) User selects the Career Planning Unit
Career Plan for Employee Employe (if more than 1 are available, else
Employee e for the value is defaulted)

Career

Plan > User directly enters the Employee
Code and takes the ‘Career Plan’ link
OR

> User conducts a search using the
filter “Planned as on Date” or “Actual
as on Date” and clicks on the multi-
line hyperlink to delete Career
Planning for the employee.
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Career >  User selects the Basis of Career Plan
Plan for combo as Career Plan and presses
Employe Get Details
e
> User deletes the Plan by using the
“Delete” button
m  Scenario 3: Request for Training
SL. | FLOW OF EVENTS PRIMARY BUSINESS ACTIVITY | PAGE FUNCTIONAL STEPS
# ACTOR(S) COMPONENT
1. User makes a Request for | HR User Record Employee | Request for Request ) User enters the Training
Training for the selected Career Plan Training for Needs, Training Area, and
Employee Training enters the Recommended

Course Code, By Date and
saves the record.

»  Upon save the Status Column
is displayed with
Recommended.

Career Planning
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m  Scenario 4: View Career Plan

SL. | FLOW OF EVENTS PRIMARY BUSINESS ACTIVITY PAGE FUNCTIONAL STEPS

# ACTOR(S) | COMPONENT

1. User Views Career HR User Employee Career | View Career | View Career User selects the Career
Planning record for the Plan Plan Plan Planning Unit (if more than 1
Employee are available, else the value is

defaulted)

User directly enters the
Employee Code and takes the
‘View Career Plan’ link OR

User conducts a search using
the filter Department, Job
Title, Position Title, Grade Set,
Grade, Work Location

The respective record for
which Career Pan is defined is
displayed in the multiline.

User can visit any of the links
Monitor Career Fitment, View
Work Experience, View
Appraisal Records, View
Employee at a Glance, View
Training requests
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m  Scenario 5: Career plan Employee Self Service

SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY | PAGE FUNCTIONAL STEPS
# ACTOR(S) COMPONENT
1. Employee records Employee Career plan Record Record Career Login user details are
Career Aspirations Employee Self Career Aspirations displayed for the self service
Service Aspirations

employee as per the primary
assignment information

Employee records the Career
aspiration by selecting the Unit
Structure Unit, enters the Job
Code, Department, Position
and selects Work Location and
Desired from and To Date

Employee saves the
information and the same is
available for the administrator
to record and view and modify
the same.

The link View Career Path is
available for the employee to
select the job, which is
defined, and View the
respective Career Path defined
for the Job thru the Set up
component for the respective
OU’s by selecting the same in
the Career Track Combo.
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SL.

FLOW OF EVENTS

PRIMARY
ACTOR(S)

BUSINESS
COMPONENT

ACTIVITY

PAGE

FUNCTIONAL STEPS

Employee modifies
the Career
Aspirations

Employee

Career plan
Employee Self
Service

Record
Career
Aspirations

Record Career
Aspirations

»  Login user details are
displayed for the self service
employee as per the primary
assignment information

» If Career Aspiration details
already exist the same is also
displayed.

»  Employee modifies the record
and saves the information

»  The link View Career Path is
available for the employee to
select the job, which is
defined, and View the
respective Career Path defined
for the Job thru the Set up
component for the respective
OU’s by selecting the same in
the Career Track Combo.

Employee deletes
the Career
Aspirations

Employee

Career plan
Employee Self
Service

Record
Career
Aspirations

Record Career
Aspirations

»  Login user details are
displayed for the self service
employee as per the primary
assignment information

> If Career Aspiration details
already exist the same is also
displayed.

»  Employee deletes the record

Career Planning
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SL. | FLOW OF EVENTS | PRIMARY BUSINESS ACTIVITY | PAGE FUNCTIONAL STEPS
# ACTOR(S) COMPONENT
by pressing the delete button.
4 Employee Views his Employee Career plan View View Employee Login user details are
Career Plan Employee Self Employee Career Plan displayed for the self service
Service Career Plan

employee as per the primary
assignment information

If Career Aspiration details
already exist the same is also
displayed.

The record saved by the
employee in Record Career
Aspirations is modified by the
administrator thru the Record
Career Plan activity and saved
and by checking the Show Plan
to Employee.

The record which is modified
by the administrator is
available for the respective
employee’s view thru his self
service login

Career Planning

F

ramco

Co-create. Innovate. Win.

D

13



Ramco Systems - Aviation & MRO Solutions @
www.RamcoAviation.com

ramco

Corporate Office and R&D Center
Ramco Systems Limited, 64, Sardar Patel Road, Taramani Chennai — 600 113, India
Tel: +91 (44) 2235 4510. Fax +91 (44) 2235 2884

www.ramco.com



	Cover Page
	Table of Contents
	Career Planning
	Scenario 1: Career Planning Setup
	Scenario 2: Performing Career Plan for Employee
	Scenario 3: Request for Training
	Scenario 4: View Career Plan 
	Scenario 5: Career plan Employee Self Service




